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Using this 
template  

The standard headings and tables in this template should be modified to meet the 
requirements of each Initial Assessment.  The sites may have diverse issues and 
constraints and problems and the standard template is therefore just a guide on 
typical requirements but flexibility is allowed to amend/ add headings as required 

 
 Hidden 
guidance  

The template contains various pieces of guidance covering content, use of tables 
etc.  The guidance is shown in blue text and can be turned ‘on’ to assist in the 
writing stages or ‘hidden’ for viewing or when printing the document.  You can 
switch between ‘hidden’ and ‘on’ and back to ‘hidden’ at any time. 

To show/hide the guidance click on the ¶ icon on the MS Word toolbar.  

If the hidden text does not disappear off the screen when the ¶ icon is clicked, go 
to:  Tools>Options>View Tab and uncheck the ‘Hidden text’ box.   

It is advisable to work with the hidden text turned on, as this helps to format new 
text and to avoid deleting the hidden text itself. 

 
Auto-
updating of 
contents 
page  

The contents page will update to reflect changed information in the main text and 
tables.  To update right click on the relevant area of the contents page, to highlight 
it, and select ‘Update Field” to access the update option. 

To enable these updating features to be created, the document contains specific 
text types and “fields”.  These are Headings 1, 2, 3 & 4; fields in the table labels 
and in the appendix labels.  When editing the document, take care to maintain 
these aspects. 

 
Inserting new 
headings  

To insert new headings in the main text go to: Format>Styles and Formatting to 
open the styles box. Insert the new headings, highlight it and click on the 
appropriate Heading level in the ‘Pick formatting to apply’ box.  Paragraph text 
can be inserted and formatted in a similar way. 

 
Inserting new 
tables  

Table labels should be added by Insert>Reference>Caption and selecting ‘Table’ 
from the drop down ‘Label’ box.  This will insert the Table title with the correct 
number and the caption can be typed in after the label.  Tables can then be cross 
referenced from the text by Insert>Reference>Cross Reference and selecting the 
appropriate reference type and caption from the drop down box and list. 

 
Numbering All paragraphs should be numbered sequentially as sub-sets of the section 

Initial assessment report  
Branksome Drive 
November 2016 
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paragraphs  number. Prompts for paragraph numbering are provided as ‘Start writing here’ 
after which pressing <return> will automatically provide the next paragraph 
number.  
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1.1  Introduction and background 

Working in partnership with the City of Bradford Metropolitan District Council, 15 locations within 
Bradford were identified to have been significantly affected by the 2015 December Floods. These 
locations were subsequently grouped into five main catchment areas to be put forward for initial 
assessments to consider the viability of a flood risk management scheme.  

 
 
1.1.1 Description of Location 

Branksome Drive is located at the confluence of the River Aire and a small, un-named 
watercourse, between Saltaire and Cottingley, West Yorkshire. The study area incorporates 
approximately 30 low lying properties at risk of flooding from the right bank of the River Aire. This 
area was severely flooded during December 2015. 

Work to establish the current standard of protection (SoP) provided by the riverbank is being 
undertaken by the Environment Agency (EA). 

According to the Index of Multiple Deprivation (IMD) reported in Appendix E, the area is amongst 
the 30% least deprived neighbourhoods in the country.  

Detailed information has been collected during the site visit in July 2016 and can be found in 
Appendix B.   Figure 1, below, shows the extent of the study area.  
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Figure 1: Study area 
 

1.1.2 Description of Watercourses and Geology 

The River Aire is a major river in Yorkshire flowing from Malham in the Yorkshire Dales, through 
the urban areas of Bradford and Leeds, before joining the River Ouse at Airmyn. The Aire is 
approximately 71 miles in length from its source to its confluence. 

The Upper Aire around Bradford is heavily urbanised and the floodplain is constrained by 
development. There are a number of tributaries within this area that respond rapidly to rainfall. 
There are also a large number of structures such as bridges and screens in this area.  

The River Aire catchment has been considerably modified for flood defence purposes. Flood 
embankments have been built up along much of the channel and there are several controlled 
washland (floodplain) areas in the upper reaches as well as downstream of Leeds. These act as 
both controlled and uncontrolled washlands and significantly attenuate peak flows along the river. 

The geology of the study area is characterised by clay, sand and silts. 
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1.1.3 History of Flooding 

There are approximately 30 low-lying properties on Branksome Drive that have suffered 
extensive flooding on several occasions in recent years. There have been widespread major 
flood events throughout the River Aire recently in 2000, 2012 and 2015. As the Branksome Drive 
properties are close to the river, these events caused flooding to significant depths. 

During the 2015 Boxing Day flood event, properties on Branksome Drive were flooded to a depth 
of approximately 1.5m from the River Aire overtopping its banks.  

 

1.1.4 Summary of Modelling Analysis 

In 2001, the Upper and Lower Aire Preliminary Strategic Reviews concluded that a combined 
hydrological-hydraulic model was required to better understand the flooding mechanisms in the 
catchment and to support the development of a comprehensive strategy to manage flood risk to 
communities in the floodplain. 

In 2001, Atkins were commissioned to deliver Phase 1 of the River Aire Modelling Study. Phase 1 
involved the collection of new topographic survey and hydrometric data, estimation of flows using 
the methods detailed in the Flood Estimation Handbook (FEH) and construction and calibration of 
a hydrodynamic model of the River Aire and associated floodplains. This further lead onto the 
development of a robust calibrated model, which was then used to undertake a series of design 
runs. 

The River Aire model reach was defined from Gargrave at its upstream extent, down to its 
confluence with the River Ouse downstream of Airmyn. In order to accommodate this long 
stretch, the River Aire was subdivided into the following three reaches and modelled accordingly: 

• “Upper Aire” - from upstream of Gargrave Bridge to Leeds Station Weir (FDMS 
reaches 16-29) 

• “Lower Aire” - from Leeds Station Weir to Fairburn Ings (FDMS reaches 12-15) 
and the Lower Calder from Stanley Ferry to its confluence with the Aire (FDMS 
reaches 1-3) 

• “Tidal Aire” - from Fairburn Ings to the River Ouse at Airmyn (FDMS reaches 1- 
11) 

The final three models combined to form a catchment wide one-dimensional hydrodynamic (ISIS) 
model which was deemed to effectively capture the flow attenuation within the catchment. The 1 
in 100 year fluvial and 1 in 200 year tidal design flood levels were key deliverables from this 
study, which was completed in autumn 2004. This work formed the basis for the Upper Aire Flood 
Risk Management Strategy which aimed to define flood risk within this area and identify potential 
flood risk management options. The FRMS proposed flood risk management options for the 
short, medium and long-term, which included progressing a flood management scheme for 
defences at Branksome Drive. 

The existing hydraulic model has allowed for climate change up to the year 2105 with a 30% 
increase to the hydrological inflow. However the guidance for climate change analysis has been 
updated since the Upper Aire Modelling Study and therefore these results are now outdated. 
Climate change modelled flood outlines were not considered in this initial assessment with 
analysis using present day outlines to assign flood risk bands. The model has not been calibrated 
since the work undertaken in 2002-2004 and should be updated including recent events, if the 
scheme progresses to OBC stage. 
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1.1.5 Drivers, Constraints, Opportunities 

Branksome Drive falls under the River Aire Catchment Flood Management Plan1 CFMP, and is 
covered by sub-area 3, Worth and Aire. The designated policy for the area at risk is Policy Option 
5: Areas of moderate to high flood risk where we can generally take further action to reduce flood 
risk. 

The following drivers, constraints and opportunities have been identified within the study area.  

Political Drivers  Summary Description 

Catchment Flood Management Plan Aire CFMP 2010 

Catchment Flood Management Policy 

Policy 4: Areas of low, moderate or high flood 

risk where the flood risk is already effectively 

managed 

Flood Risk Management Strategy 

Short-term recommendations from the Upper 

Aire Flood Risk Management Strategy included 

progressing a flood management scheme at 

Branksome Drive 

Economic Drivers   Summary Description 

Funding Time Constraints 

Must be obtained within 6 year programme of 

capital investment 

Technological Drivers  Summary Description 

Improved Public Safety Via reduced flood risk 

Environmental Constraints  Summary Description 

SSSI 

Bingley South Bog SSSI 1km northwest of study 

area 

World Heritage Site 

The Saltaire World Heritage site is 

approximately 1.5km East from the study area. 

 

1.2 Problem and objectives 

 
1.2.1 Problem 
 
The event of the 25th to 29th December 2015 was the result of a weather front which travelled in 
a north easterly direction immediately following behind Storm Eva. The front first passed over 
West Yorkshire before heading across through North Yorkshire. 
The more significant rainfall totals and rainfall return periods occurred for the peak 24 hour and 
36 hour period over the 25th and 26th December. During this time, the average monthly rainfall 
for December fell over the Pennine edge of West Yorkshire and through central North Yorkshire. 
Rainfall return periods of more than 1 in 50 years were recorded in parts of the Upper Calder, 
Upper Aire, and Middle Wharfe catchments for the 24 hour peak totals. 

The only data available, regarding the flow in the river Aire at Branksome Drive, is from a gauge 
station located approximately 10 Km upstream of the site. At the Kildwick gauging station   a flow 
of 163 m3/s was recorded which corresponds to an 80- 100 years return period. Note that the 
return period of rainfall and flow is quite different, this is because the rainfall fell on already 
saturated ground and into rivers that were already high. 

                                                
 
1 . https://www.gov.uk/government/publications/river-aire-catchment-flood-management-plan 
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The site is at risk of flooding from various sources, including that from surface water. There are 
approximately 30 low-lying properties at risk that have been flooded during past events. The 
lower lying of these properties were flooded to a depth of 1.5m during the 2015 Boxing Day 
event. 

The following possible flooding mechanisms have been identified: 

• Surface water flooding from run-off from the surrounding hills flowing towards the study 
area.  

• There is a combined sewer that discharges into the river at this location, during high 
river levels this sewer cannot discharge and backs up causing flooding to nearby 
properties.  

• Flooding due to groundwater  

• Fluvial flooding from the River Aire overtopping its bank 

This report will identify potential solutions to the fluvial flooding and determine if there is scope to 
determine the best cost/benefit solution to manage this flood risk. 

 

1.2.2 Objectives 

The primary objective of this initial assessment is to undertake a scoping study for the area to 
identify the flood risk issues and viable solutions for the affected properties, and to identify any 
other potential flood risk management measures which are consistent with the current CFMP 
(Catchment Flood Management Plan). 

The purpose of this report is to lay the groundwork and, where applicable, provide a business 
case for future appraisal. The report aims to achieve the following: 

• Confirm the need for a project; 

• Identify the issues and Political, Environmental, Societal, 
Technological, Legislative and Economic (PESTLE) drivers and 
opportunities related to the need; 

• Identify the options to address the need and problem; 

• Demonstrate that viable options exist based upon the available 
information; 

• Provide sufficient information to allow the packaging and optimisation of 
future appraisal, design and construction packages; 

• Provide sufficient information for the appraisal scope to be prepared; 

• Make an assessment on the deliverability of the project; 

• Provide a basis/starting point for discussion with communities and 
partner organisations for use in the development of potential schemes 
and negotiations regarding funding contributions. 

1.3 Benefits 
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In order to make an initial quantification of the potential benefits of a scheme, the Upper Aire 
FRMS modelled flood outlines (Atkins, 2004) were used to estimate the properties currently 
located within each risk band. Properties within the 1 in 25 year outline were assessed as being 
in the Very Significant risk band. Properties within the 1 in 75 year outline were assessed as 
being in the Significant risk band, and Properties within the 1 in 200 year outline were assessed 
as being in the Moderate risk band. 

 

 Table 0.1 Number of Properties at Risk (based on current outlines) 

Property Type Flood Risk Number of 
Properties 

≥1 in 25 year (4% AEP) 
(Very Significant Risk) 

29 

<1 in 25 year (4% AEP) 
≥1 in 75 year (1.33% AEP) 
(Significant Risk) 

0 Residential  

<1 in 75 year (1.33% AEP)  
≥1 in 200 year (0.5% AEP) 
(Moderate Risk) 

0 

≥1 in 25 year (4% AEP) 
(Very Significant Risk) 

1 

<1 in 25 year (4% AEP) 
≥1 in 75 year (1.33% AEP) 
(Significant Risk) 

0 Non-Residential 

<1 in 75 year (1.33% AEP) 
≥1 in 200 year (0.5% AEP) 
(Moderate Risk) 

0 

Details of the methodology used for assessing the benefits of each option are presented in 
Appendix D. It should be noted that the methodology uses the Weighted Annual Average 
Damages (WAAD) data from the MCM (2015/16 prices). While this approach gives a first 
approximation it is recommended that a more detailed assessment is carried out if this project is 
progressed further, to better estimate the economic benefits of the proposed works. 

 

1.4 Options 

A long list of options has been compiled for the study area and is summarised in the table below. 
The table shows the range of options considered and the reasoning for or against them being 
taken forward to the shortlist of options to be assessed.  
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Category Long List 
Option 

Description Take Forward 
for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

Do nothing Do nothing All operational and maintenance 
activities cease 

Yes Required to support development of 
business case and benefit cost ratios. 

Do minimum Do Minimum Continue with current operational 
and maintenance activities.  

Yes Required to support development of 
business case and incremental b/c ratio. 

Non-structural 
(by EA) 

Improved flood 
warning 

Enhanced flood warning to allow 
residents to prepare plus appropriate 
implementation of flood action plans 

No Not funded via the capital programme.  
A Flood warning system is already in 
place for Nab Wood and Branksome 
Drive. It was reported that flood warnings 
were not received prior to the Boxing Day 
event.   
Improving the current system would 
require further modelling which is beyond 
the scope of this study. 

Non-structural 
(by EA) 

Flood action 
plans 

Improved direction of reactionary 
flood defence measure (fire crews, 
temporary pumps, etc.) 

No The study area is already within a Flood 
Warning and Flood Alert area operated 
by the Environment Agency. 

Property level 
protection 

Property level 
protection 

Protection to individual properties 
(e.g. via air brick covers, door guards 
etc).  

Yes This may be viable given the high risk 
and relatively small number of properties. 
This would not have been effective in 
flooding of the depths experienced in 
December 2015 

Operational 
(by Others) 

Improve 
operation/design  

Improve operation/design of assets 
not owned by the EA 

No No third party assets affecting fluvial 
flood risk in the study area. 

Urban 
drainage 

Improve urban 
drainage. 

Improved surface water drainage 
system. 

Yes During high river levels the sewer cannot 
discharge and back up causing flooding. 
A pumping station could be an option, to 
reduce the risks during flood incidents. 

Structural Earth bunds Flood bund  Yes A bund around the river-side of the low-
lying properties would reduce the flood 
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Category Long List 
Option 

Description Take Forward 
for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

risk to these properties from the river.  
Due to the flood damage caused to 
properties in this area it is worth 
investigating the viability of constructing a 
bund at this location.  

Structural Conveyance Channel deepening or widening No There is no available route or space for 
this option. 

Structural Conveyance Supplementary bypass channel(s), 
tunnels or floodway 

No There is no available route or space for 
this option. 

Structural Conveyance River restoration and/or pinch point 
improvements (bridges, culverts and 
weirs) 

No There are no significant pinch points 
nearby contributing to flood risk  

Flood storage 
area  

Online Use of active structures and re-
profiling to store water online.  

Yes The area immediately upstream of 
Branksome Drive could be used as a 
flood storage area (although may not be 
effective as volume is small compare to 
the upstream catchment).  
A large scale FSA system was 
considered in the upper Aire SFRA, it will 
have a large impact beyond the 
Branksome Drive area, and is considered 
to be outside of the scope of this 
appraisal. 

Flood storage 
area 

Offline Gravity or pumping to offline storage 
area 

No No offline storage sites with potential for 
a significant impact on flood risk have 
been identified 
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1.4.1 Shortlisted Options Description 
The options below were chosen to be taken forward for assessment in the initial assessment 
 
Do Nothing  

The Do Nothing option is defined as taking no action whatsoever; under this option all 
management activities would cease, including maintenance and repair work to existing assets. 

Under this assumption, the natural deterioration of the river channel will occur, leading to an 
increase in flood risk. There are no assets within the study area to be considered. 

The Do Nothing option is not to be taken forward as a viable option as it results in an 
unacceptable increase in flood risk to people and property due to failure and deterioration of 
assets. However, it needs to be considered to measure the benefits of the other options. 

Do Minimum 

The Do Minimum option is defined as the minimum level of action or intervention necessary to 
continue to maintain and operate the current flood risk management arrangements offered 
throughout the study area. It will form the appraisal baseline.  

This option assumes continuation of the existing maintenance regime.  This includes channel 
maintenance, operation and maintenance of weirs and other in-channel structures and where 
possible, existing non-structural measures such as flood forecasting and flood warning.  

The advantage of Do Minimum is that it sustains the current standard of service within the study 
area and there are no increase in costs associated with this option.  

The disadvantages of Do Minimum is that the current maintenance regime is not believed to 
significantly reduce the flood risk to people and properties in the study area. It does not account 
for the future increase in flood risk due to climate change. A further solution would therefore be 
required in order to reduce the effect of higher frequency flood events expected in future.   

There are no indicators to suggest that this option is non-viable or undeliverable.    

Option 1: Property Level Protection 

This option is to offer property level protection (PLP) to the 29 ground floor residential properties 
in the Very Significant risk band. PLP can take the form of barriers in doorways, non-return valves 
fitted to drains, and airbrick/vent covers. Properties can also be made more flood resilient, using 
waterproof plaster, solid concrete floors or tiled floor coverings in order to reduce the amount of 
time and money needed to recover from a flood event. PLP is generally used as an option for 
properties that experience less than 500mm of flooding. 

Advantages of this option include the fact that defences have minimal visual and land impact, and 
do not remove any of the flood plain area. PLP can help protect against surface water as well as 
fluvial flooding. Any changes would need to be in keeping with the surroundings. 

Disadvantages of this option include the requirement for residents to receive sufficient warning 
and for them to be available and trained in deploying PLP measures. Furthermore, PLP does not 
provide any wider environmental benefits, and does not prevent the flooding of areas surrounding 
the property. PLP is also only considered viable for properties in the Very Significant risk band 
(based on NaFRA), and where flooding is less than 500mm deep. The effectiveness of PLP 
reduces with long duration floods due to seepage. 

The event that occurred on Boxing Day 2015 was an extreme event. For such an extreme event, 
PLP would not be applicable but for less severe events would be effective. 



 

IMNE790567-CH2-FEV-BD0-AS-C-0001 Page 12 

Deliverability of this option is reliant on the residents up take of PLP. 

 

Option 2: Earth Bund around properties at risk 

This option is to construct a flood bund around the low-lying properties on Branksome Drive at 
risk from flooding. The bund is to be as close as possible to the properties at risk, in order to 
minimise the area removed from the flood plain, and therefore minimising the compensatory flood 
plain creation required. The design of the flood bunds must be made to fit visually in to the 
surrounding area, especially due to their close proximity to properties. 

The Standard of Protection offered by these flood bunds is 1 in 100 in the current scenario, and is 
expected to be approximately 1 in 75 at the end of the appraisal period, including the effects of 
climate change. The alignment of the bunds and their dimensions are an estimate for this initial 
assessment. The costs are based on an embankment with a length of 240 m, 1.5m height and 
12m width at the base; figure 2 shows an approximate alignment of the asset. On the east side of 
the study area there is a small un-named watercourse. At this stage the bund is thought to protect 
the site against flooding from the River Aire; if this option is taken forward, alignment and 
dimensions will have to be assessed and optimised in order to consider all potential sources of 
flooding and an appropriate standard of protection.  

 

Figure 2: Alignment of the Earth bound in Branksome  Drive 
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This option is a permanent structure and does not require any operational input. This will move 
the properties on Branksome Drive from the very significant risk band to the low risk band. 

Further modelling would be required in order to assess the impact of removal of flood plain due to 
the construction of this flood bund on communities further downstream. Compensatory flood plain 
storage may be required, adding to the costs of the scheme. It must be ensured that the 
compensatory storage is hydraulically linked to the flood plain lost, otherwise the benefits from it 
may not be fully realised. With this option impacts on groundwater and surface water flooding 
must also be investigated. 

A high level bund would not be viable, as the bunds require side slopes of 1:3, and this leads to a 
very large footprint. Construction of the bund has the potential to cause temporary disruption to 
roads and properties.  

Option 3: Online flood storage area upstream of Bra nksome Drive 

This option is to utilise the area on the right bank of the River Aire, upstream of the properties at 
risk, to create a formalised flood storage area. The scheme would incorporate ground re-profiling 
to enable flows to come out of bank and be stored in the existing farmland area, behind raised 
earth embankments. The total area occupied by the FSA will be approximately 15000 m², 
requiring approximately 240m in length of embankments (2 m high by 15 m wide). It is assumed 
this storage area would be sufficient to attenuate flood peaks, benefitting to properties that lie in 
the study area and downstream, however hydraulic modelling will be required to check this at 
appraisal stage. 

If proven technically viable through hydraulic modelling, this option could increase the standard of 
protection to properties in the study area and potentially downstream, by providing upstream 
storage to attenuate flood flows. It is a permanent defence solution that does not reduce the 
capacity of the river and increases connection between the river and the floodplain. 
Embankments can be made to fit visually within the surrounding area. 

There may be aesthetic and landscape impacts associated with this option. The proposed 
location is on private land and would therefore require land negotiation. An increase in 
maintenance commitment will be required to control vegetation. 

This option requires testing in the hydraulic model to confirm its viability and effectiveness. The 
option is technically feasible however there are risks associated with gaining land owner consent. 
However, the standard of protection provided by this scheme is highly uncertain until further 
modelling is carried out.  

A simplified representation of the storage area is shown in figure 3 
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Figure 3: Location of the storage area 

 

1.4.2 Costs of options 

The costs for the options were calculated using the Environment Agency’s Project Cost Tool and 
Long Term Costing Workbook.  

It is assumed that a major replacement of assets will be required at some point during the 
appraisal period after the initial construction phase. The timing of these replacements is based on 
the EA’s Asset Deterioration Guidance (2013), an appraisal period of 100 years has been used 
and the assumptions are outlined in Appendix A. Table 1.2 shows the initial costs for the options, 
it is assumed that replacement of the assets will be required when the assets reach Condition 
Grade 4 (CG4): 20 years for the Option 1 (PLP) and 60 years for the option 2 and 3 
(embankment). 

 

Table 0.2 Project costs (£k) 
Item Do Minimum Option 1 Option 2 Option 3 

Construction Base Cost    237.0 326.3 1740.5 

Environment Agency staff   37.4 51.6 130.0 

Consultant fees (appraisal)  15.2 20.9 90.5 

Consultant fees (design)  51.4 70.8 247.2 

Consultant fees (construction)  13.3 
 

18.3 102.7 

Surveys (Ground 
investigation) 

 2.4 
 3.3 60.9 

Surveys (Ground 
investigation) 

 
         0.9 1.3 8.7 

Land purchase   0.2 0.3 8.7 
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Item Do Minimum Option 1 Option 2 Option 3 

Sub-total   357.8 492.7 2389.1 

Optimism Bias  157.4 216.8 1051.2 

TOTAL  515.2 709.4 3,440.4 

Annual operations and 
maintenance costs 541 £/year 541 £/year 716 £/year 716 £/year 

 
 

1.5 Initial environmental assessment 

Table 0.3 Key environmental impacts, mitigation and opportunities 

Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

Option1 
-Reduced risk of fluvial 
flooding, 
-Low risk of pollution incidents 
and disruption to area during 
construction. 
-Low aesthetic effect 

  

Option 2    

-Reduced risk of flooding 
-Low aesthetic effect 

Construction work takes place 
alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance 

Option 3    

-Reduced risk of flooding 
-Low aesthetic effect 

Construction work takes place 
alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance 

 

1.6 Consultation 

The options in this appraisal were developed in consultation with the Environment Agency and 
Bradford MDC. No public consultations were held at this stage as the work is a high-level 
assessment of potential options. Stakeholder engagement will take place at subsequent stages of 
the project. 

If this project is taken forward for further appraisal it is recommended that consultation is focused 
on, but not limited to, the following: 

• Residents in the area at risk 

• Landowners and developers for the upstream storage option. 

• Riparian landowners, especially owners of riverside walls acting as informal defences. 
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1.7 Economic summary and preliminary preferred opti on 

Table 0.4 Benefit-cost assessment  
 PV costs 

(£k) 
PV benefits  

(£k) Av. BCR Incr’ BCR Option for 
iBCR calc Comments 

Do Nothing       

Do Minimum  16 51 3.1 

 

 
Preferred option 
due to highest 

ABCR 

Option 1 1062 561 0.6 0.5 
Do 

Minimum 
 

Option 2 826 1302 1.6 1.6 
Do 

Minimum 

Preferred Do 
Something Option 
due to ABCR and 

IBCR 

Option 3 3922 1302 0.3 0.3 
Do 

Minimum 

IBCR from Do 
Minimum as 

benefits are the 
same as Option 2 

 
As stated in the Handbook for Economic Appraisal 2016, the benefits referred to for option 1 
(PLP) are factored by 0.75 to take account of the risk of incorrect use. 
 
Table 0.5 Benefit-cost ratios and outcome measures  
Contributions to outcome measures  Option 1 Option 2 Option 3 

OM1 – Economic Benefit:     

    Benefit period used for Partnership 
Funding calcs 

20 60 60 

    PV Benefits (£k) 278.49 1233.80 1233.80 

    PV Costs (£k) 523.19 835.45 3979.27 

    Benefit/Cost ratio 0.53 1.48 0.31 

OM2 – No. of households moved out of any 
flood probability category to a lower category 

29 29 29 

OM2b – No. of households for which the 
probability of flooding or coastal erosion is 
reduced from the very significant or 
significant category to the moderate or low 
category 

0 29 29 

OM2c – No. of households in the 20% most 
deprived areas moved from the very 
significant or significant flood probability 
category to the moderate or low category  

0 0 0 

OM4a – Hectares of water dependent habitat 
created or improved to help meet the 
objectives of the Water Framework Directive 

0 0 0 

OM4b – Hectares of intertidal habitat created 
to help meet the objectives of the Water 
Framework Directive for areas protected 
under the EU Habitats/Birds Directive  

0 0 0 

OM4c – Kilometres of rivers protected under 
the EU Habitats/Birds Directive improved to 
help meet the objectives of the Water 
Framework Directive 

0 0 0 

Partnership Funding (PF) Score  13% 24% 5% 

Contributions required for a PF score of 
100% (£k) 

457.3 635.0 3779.0 
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Contributions required for a PF score of 
120% (£k) 468.0 668.0 3812.0 

1.7.1 Funding and contributions 

A funding analysis tool was used to identify potential direct and indirect beneficiaries of the 
scheme. This is included in Appendix C. Based on these beneficiaries potential funding sources 
identified include: 

• Community Infrastructure Levy 

• Benefitting local businesses 

• Council Tax 

• Local Enterprise Partnerships 

There are a large number of commercial properties at risk within the town. Further consultation 
would be required to identify potential contributions.  

1.7.2 Key delivery risks (economic, social and environmen tal) 
 
Table 0.6 Risks and mitigation  

Risk Key Mitigation 

Estimate of benefits highly uncertain Undertake more detailed benefit 
calculations at OBC stage 

Risk of pollution incidents and disruption to area 
during construction  

PLP may not be effective for the properties due 
to flood depths, durations and presence of 
groundwater risk. 

 

The height  of the embankment for  options 2 
and 3 is estimated, and may be insufficient  for  
the SOP required for an event of the magnitude 
of Boxing Day 2015 

Undertake further modelling work to 
establish the correct level of the defences 
for such an event. 

 

1.8 Project Scoring 

The data used in this assessment has been subjected to a RAG assessment. A green score is 
well defined, not likely to be an issue: amber score, needs development, but is manageable: red 
score is poorly defined, lots of uncertainty, likely to cause significant problems. The RAG 
assessment gives a three figure score with the first number being the number of reds with the 
second and third numbers being the number of amber and green respectively. The results are 
shown below: 
 

• A – Problem Definition: The fluvial flood risk is well understood but more accurate 
information is needed about the sewer and the ground water – AMBER  

 
• B – Economic Case: The benefits assessment has been based on moving properties from 

flood risk bands and weighted average annual damages – RED 
 

• C – Funding: All The options require external funding. Work will be needed to obtain 
funding but there are opportunities – AMBER  

 
• D – Engineering case: Solutions taken to outline design are common defence options, no 

particular issues are expected – GREEN 
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• E – Permissions & Consents: Solution are unlikely to require unusual permissions or 
consents, but permission for third party properties is required  – AMBER  

 
• F – Environmental sensitivities: An Environmental check list has been completed and the 

options will not have any impact on any nearby sites of interest – GREEN 
 

• G – Opportunities: Some potential opportunities for partnership working but minimal 
environment opportunities – AMBER  
 

 
Model. 

A 

Econ 

B 

Funding  

C 

Eng. 

D 

Permission  

E 

Env. 

F 

RAG Opps. 

G 

2 3 2 1  2  1 132 2 

 
 

1.9 Further work requirements 

If the project is taken forward for further appraisal it is recommended that the following work is 
undertaken to confirm the feasibility of the options 

• Hydraulic modelling for the proposed earth bund around the properties  

• Topographic survey and ground investigation for the earth bund 

• Effect on groundwater and surface water run-off of the options 

• Update the PV benefits and re-assess the partnership Funding score. 

• Consultation with landowners  

 
 

1.10 Conclusions and Recommendation 

The Do minimum option has the highest BCR because of the very low cost of the option, but this 
option offers the lower benefits. The properties remain in the current risk band and with the 
current SoP. Option 2 is the next highest option with an iBCR of 1.55 against Do Minimum. As 
such this is the preferred option from this appraisal. However, there are considerable 
uncertainties in the assessed costs and benefits and the preferred option may change with further 
appraisal. This option will require significant funding contributions but is a viable option and could 
be considered for further appraisal. 
 
Further analysis is recommended to evaluate the risk of groundwater flooding. If there is 
significant risk present this will reduce the effectiveness of all the proposed options.   
 
A large scale Flood storage Area (FSA) system is considered in the long list of options. This is a 
large-scale scheme that will have significant impacts beyond the Branksome Drive area and is 
considered to be outside the scope of this initial assessment. It is recommended that this is 
considered in future work to provide protection to Branksome Drive.  
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Appendices 


